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Chapter 1

MagnifiCAD_help

1.1 MagnifiCAD Help v1.0

MagnifiCAD v1.0 Online Help

(C)1995 Anders Granli. All rights reserved.
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1.2 secintro

Introduction

Welcome to the first version of MagnifiCAD. MagnifiCAD is a computer-aided design program, which allows you to produce
drawings in 2D with the help of a variety of tools.
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MagnifiCAD supports different line styles, hatching, colors, and can exchange files with other CAD packages supporting the
DXF file format.

System Requirements

Registration

Drawing elements and their representation

1.3 secscreen

Screen Elements

The default MagnifiCAD screen setup consists of two windows: the Tools Palette and a Project Window. In addition to these,
other palettes can also be displayed.

Tools Palette

Project Window

1.4 sectypes

Types of drawing tools

The tool palette contains all the tools you need to draw. The tools are divided into modifiers and operators.

The drawing modifier tools are the element generation modifiers and the self/copy modifiers.

The drawing operators are the element generation tools, pick/delete tools, geometric transformations and attribute assignments.

1.5 secgener

Generating elements

The drawing tools are used to create different drawing elements. When you select a tool, instructions will be shown in the text
information bar about what the tool does.

Any time during a drawing operation, you can press the right mouse button to cancel the process. The rubberbanding will be
deleted from the screen.

The Shift keys can be used to close a polyline or a polycurve.

1.6 secpicki

Picking

When the user wants to edit an object, that is, apply a transformation or delete it, the object must be picked.

Prepick and Postpick

The Pick Tool

Unpicking

1.7 secdelet

Delete

Delete is used when an element is to be erased from the project.

The Delete Tool
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1.8 secgeome

Geometric Transformations

The Geometric Transformations operate on an element to change its geometry. The Self/Copy modifiers affect the transforma-
tions.

The Self/Copy Modifiers

The Geometric Transformations

Transforming Objects

1.9 seceleme

Element Attributes

All the drawing elements have attributes that can be set and changed. These attributes are color, line style, line weight, hatch and
the layer they are in.

Some elements are affected by all these attributes, and some are affected by some of them, as shown in the table below.

<TABLE>

Setting the element attributes

1.10 secsymbo

Symbols

Symbols are used in a drawing to represent elements that are repetitioned. They can be used to standard symbolic representation
like doors, windows, furniture, etc. in drawings.

Symbols are not affected by the hatch attribute, and they may not be rotated.

Creating Symbols

Placing Symbols

Exploding Symbols

1.11 secsnapm

The Snap Modes

The Snap modes determine what happens to the input coordinates, if they are adjusted (snapped), and to where. When an input
point is snapped, the actual coordinate recorded is changed to fit the current snap mode.

Grid snap

Directional snap

Object snap
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1.12 secmenus

The Menus

From the menus the user can access all the functions not covered in the tools palette.

Project Menu

Edit Menu

View Menu

Information Menu

Symbols Menu

Settings Menu

Lines Menu

Help Menu

1.13 introsyste

System Requirements

MagnifiCAD requires:

o An Amiga with 68020 and Workbench 2.0

(preferrably 3.0) or above (i.e. a 1200/4000).

o about 300K free memory.

The size of the projects is limited only by how much free memory you have in your Amiga.

1.14 introregis

Registration

MagnifiCAD is a ShareWare program and may be distributed freely. No charge may be taken other than the cost of distribution.
This version was released 01.06.95, and is restricted to 2D drawing.

To become a registered user of MagnifiCAD and get the latest version, please send $15 to:

Anders Granli

Øvre Møllenberg gate 64

N-7043 Trondheim

NORWAY

phone: +47 73522846

e-mail: granli@stud.unit.no

www: http://www.stud.unit.no/~granli/

Comments, wishes for the next version & bug reports for this version are welcome, preferrably by e-mail. For more information
about registration, printed manuals for the program and the next version of MagnifiCAD, please mail me.
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1.15 introdrawi

Drawing elements and their representation

MagnifiCAD has four different types of drawing elements: polylines, arcs, text and symbols.

The polylines and the arcs are the common drawing elements, they are the real elements that make up a drawing. The other two
types, text and symbols, play a supporting role in a drawing.

A polyline is a series of connected line segments, and may be open or closed. A polyline may consist of only one line segment.
A special polyline type, the rectangle, is constrained to preserve its rectangular shape.

An arc is represented by the parameters that are used to generate it, not by line segments such as in polylines. An arc can be open
(a partial circle) or closed (a full circle or ellipse).

Text elements consists of a character string and can only be placed horizontally.

Symbols are elements composed of several other elements and are useful for repetitions. When the symbols are created, they are
placed in a library of symbols, from which they may be retrieved and repeatedly placed in a drawing as many times as necessary

1.16 screentools

The Tools Palette

The tools palette contains all the tools you use to draw and modify entities.

Line Mode

Enclosure Mode

Polycurve

Polyline

Rectangle

3-point Rectangle

Circle

Ellipse

Arc

Counter-clockwise Arc

Text

Polygon

Delete

Pick

Self

Copy

Move

Rotate

Set Color

Set Hatch

Set LineStyle

Set LineWeight

Set Layer

Set All
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1.17 screenproje

The Project Window

The Project Window consists of several components, such as:

The Window Border - where the projects name and the current layer will be displayed, and where you can resize and move the
window as a normal Intuition window.

The Coordinates and Snap Bar - where you can see the current coordinate, the angle, and select different types of snaps to be
applied to the input points.

The Drawing Field - where the projects elements will be shown.

The Text Information Bar - where text information about tools is displayed.

1.18 projwinborder

The Project Window Border

The border of the project window contains the name of the current project, the current working layer, and scrollers used to move
the current view. There are two scrollers, one for vertical and one for horizontal movement.

1.19 projwincoordsnapbar

The Project Window Coordinates and Snap bar

The coordinates and snap bar contains information about the current input point and the tools to affect the input points.

Coordinates

The coordinate gadgets shows the coordinates of the current position on screen. This will be absolute values, except when in the
middle of a drawing operation, when the coordinates will be relative to the first input point.

The user can also type in values in these gadgets, instead of using the mouse to select points.

The angle gadget shows the current angle. This angle will be measured from the rightmost end of a circle, except when in the
middle of some drawing operations, when it will be measured from the line between the first and second input point.

Snap gadgets

The snap modes determine how the input points will be selected. The modes are divided into three groups, called Grid Snap,
Directional Snap and Object Snap.

1.20 projwinfield

The Project Window Drawing Field

The drawing field is where you build up your project or drawing. The current drawing mode is selected and shown in the Tools
Palette.

The current coordinate is shown and the snap mode is selected in the Coordinates and Snap Bar.

1.21 projwintextbar

The Project Window Text Information Bar

The Text Information Bar will show instructions about which tool that is active, and what operation the next mouseclick will
perform.
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1.22 typesmodif

The drawing modifiers

The modifier groups occupy one row in the tools palette each.

The Element Generation Modifiers

These modifiers occupy the first row of the tools palette. They determine which type of element the drawing operators will
generate. The two types are Line mode and Enclosure Mode.

The Self/Copy Modifiers

These modifiers occupy the eight row of the tools palette. They determine whether geometric transformations will be applied to
the original object (Self) or a copy of the object (Copy).

1.23 typesopera

The drawing operators

The second group in the tools palette contains the drawing tools. These generate line or enclosure elements, depending on the
active element generation modifier.

Draw Polyline

These tools draw open or closed polylines. This may be polylines or polycurves.

Draw Polygon

These tools draw polygons. This may be rectangle, 3-point rectangles or n-sided polygons.

Draw Arc

These tools draws open or closed arcs. This may be arcs, circles or ellipses.

Pick

This tool is used to select elements. It allows elements to be prepicked, so that an operation may be applied to an element
afterwards.

Delete

This tool is used to delete elements.

Geometric Transformations

These tools is used to apply geometric transformations to elements. The available transformations are move and rotate. They
operate either on the selected elements or copies of these. This is determined by current state of the Self/Copy modifiers.

Attribute Assignment

These tools are used to assign attributes to drawn elements. The available attributes are color, line style, line weight, hatch and
layer.

1.24 tool_linemode

Line Mode Tool

When Line Mode is selected, all elements will be generated with simple lines making up the element.

1.25 tool_enclosuremode

Enclosure Mode Tool

When Enclosure Mode is selected, all elements will be generated with two parallell lines all the time, making a kind of enclosure.

This is very useful for drawing walls etc.
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1.26 tool_polyline

Polyline Tool

It draws a sequence of lines, linked to each other, by selecting a sequence of points. After the first point is selected, the first line
segment will be rubberbanded. The next selected point will end the first segment and begin rubberbanding another.

The sequence is terminated by double-clicking the mouse.

Double-clicking to end the polyline will draw an open shape, with the endpoint where you double-clicked the mouse. You can
hold down either of the shift keys on your keyboard while double-clicking to make a closed shape.

The point where you double-clicked will then be joined to the starting point of the polyline, closing the shape.

1.27 tool_polycurve

Polycurve Tool

This tool is used to draw curved lines.

NOT AVAILABLE IN THIS VERSION

1.28 tool_arc

Clockwise Arcs Tool

It draws an arc using three input points. The first point is the center of the arc. The second point defines the start point and the
thrid defines the end point of the arc.

A circle will be rubberbanded when you have selected the center, and it will change to an arc when you select the start point.

The number of segments the arc consists of, can be changed in the Circle/Ellipse/Arc Options requester.

1.29 tool_counterarc

Counter-clockwise Arc Tool

The counter-clockwise arcs is drawn as the clockwise arcs, except that they are drawn in counter-clockwise direction.

The number of segments the arc consists of, can be changed in the Circle/Ellipse/Arc Options requester.

1.30 tool_circle

Circle Tool

It draws a circle from two input points. The first point is the center, and the second point is the radius. The circle is rubberbanded
after you have selected the center point.

The number of segments the circle consists of, can be changed in the Circle/Ellipse/Arc Options requester.

1.31 req_ceaoptions

The Circle/Ellipse/Arc Options Requester

This requester handles the options for the circle, ellipse and arc tools.

# Of Segments - The number of segments required can be entered in this numeric field. The number must be greater than 6. The
default number of sides is 48.



MagnifiCAD_help 9 / 28

1.32 tool_ellipse

Ellipse Tool

It draws an ellipse from two input points. The first point is the center, and the second point is any point on the circumference of
the ellipse. After the center point is selected, the ellipse is rubber-banded.

The number of segments the ellipse consists of, can be changed in the Circle/Ellipse/Arc Options requester.

1.33 tool_rectangle

Rectangle Tool

It draws a rectangle from two input points that represents two diagonally opposite corners of the rectangle. After the first point is
selected, the rectangle will be rubber banded until you select the second point.

The input points can be any pair of opposite corners of the rectangle. The rectangle may be a square or a plain rectangle.

The sides of the rectangle are restricted to being parallell with the x and y axes of the coordinate system.

1.34 tool_rectangle3

3 Point Rectangle Tool

It draws a rectangle from three input points. The first point is represents one corner of the rectangle, the second determines the
angle of one of the rectangle sides, and he third is the corner point opposite of the first.

The rectangle will be rubber-banded after selecting the first 2 points.

The rectangle may be a square or a plain rectangle.

1.35 tool_polygon

Polygon Tool

It draws a polygon from two input points. These points represent the center og the polygon and the radius of the circle the
polygon is inscribed in.

When you select the center point, the polygon will be rubber banded until you select the radius and direction. By default this tool
creates a hexagonal shape.

The number of sides the created polygon will have can be changed in the Polygon Options requester. You invoke this requester
by holding down either of the shift keys while selecting this tool.

1.36 req_polyoptions

The Polygon Options Requester

This requester handles the options for the polygon tool.

# Of Segments - The number of sides required can be entered in this numeric field. The number must be greater than 2. The
default number of sides is 6.
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1.37 tool_text

Text Tool

The Text Tool draws text. You specify one input point, which is the start position of the text. When selected, a requester will pop
up and let you type the text. Press Return and OK in the requester, and the text will be displayed.

The Text can be moved and copied as other elements, but not rotated. It will always be drawn parallell with the x-axis.

The Font and String can be changed in Entity Info requester.

1.38 pickiprepi

Prepick and Postpick

An object may be prepicked or postpicked. Using Prepick, select the object (using the Pick Tool) first, and then apply the
operation. With Postpick, you can select an operation, and then pick the objects to be affected.

1.39 tool_pick

Pick Tool

The Pick Tool allows you to select elements on screen by various methods.

You can select one or more elements with this tool.

· Clicking on any part of an element selects it.

· Clicking on any part of an entity, while holding down the SHIFT key, selects this in addition to any already selected elements.

· Clicking outside any element deselects all elements.

· Clicking and holding down the left mouse button while dragging the mouse produces a rectangle. All elements within this
selection rectangle will be selected when yourelease the button.

When an element is selected, it is higlighted in the current selection color.

1.40 pickiunpic

Unpicking

To unpick or deselect objects, click outside any objects in the project window while in Pick Mode.

1.41 tool_delete

Delete Tool

This tool deletes the selected element or elements.

It works with both the prepick and postpick methods. With the postpick method, the Delete Tool is selected first, and then the
entities are selected and deleted.

With the prepick method, all the elements are selected first, and when the Delete Tool is selected, all selected elements are
deleted. Selected elements can also be deleted by pressing the ’Del’ button on the keyboard.
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1.42 geomemodif

The Self/Copy Modifiers

The Self/Copy modifiers control whether the transformations are applied to the selected object or to a copy of it.

Self

Copy

1.43 tool_self

Self Mode

When the Self mode is active, all geometric transformations will be applied to the selected element.

1.44 tool_copy

Copy Mode

When the Copy mode is active, all geometric transformations will be applied to a copy of the selected element.

A new copy of the selected element is made for each subsequent mouse click.

1.45 geometrans

The Geometric Transformation Tools

The Geometric Transformation Tools are used to transform or change already drawn entities.

Move

Rotate

1.46 tool_move

Move Tool

The Move Tool allows you to move one or more entities. The entities must be pre-picked with the pick tool.

To move the selected entities, select a point as your reference. This point can be anywhere, but preferably it is one of the entities
points. When this point is selected, you can drag the entity or entities to the destination point and click to move.

1.47 tool_rotate

Rotate Tool

The Rotate Tool allows you to rotate one or more entities. The entities must be pre-picked with the pick tool.

To rotate the selected entities, select a point as your reference. The entities will be rotated around this point. When selected, you
can drag the entities to their new positions and click to end the operation.
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1.48 geomeobjec

Transforming Objects

All elements support both the transformations above, except the Text element. This can only be moved, not rotated. If a rotation
is applied to a Text element, only the starting point of the Text will be rotated/moved.

Symbols also has some restrictions.

1.49 elemesetti

Setting the element attributes

When new elements are drawn, they will have the attributes currently set. These attributes are color, line style and line weight.
They will also be placed in the currently active layer.

The hatch attribute must be set explicitly.

After an element has been drawn, these attributes may be changed by using the attribute setting tools, found at the bottom of the
Tools Palette.

Set Color

Set Hatch

Set Line Style

Set Line Weight

Set Layer

Set All

1.50 tool_setcolor

Set Color Tool

This tool changes the color of the selected element to the current selected color.

The currently selected color can be changed by selecting a new color in the Color Palette.

1.51 tool_setlinestyle

Set Line Style Tool

This tool changes the line style of the selected element to the current selected line style.

The currently selected line style can be changed in the Line Menu.

1.52 tool_setlineweight

Set Line Weight Tool

This tool changes the line weight (or line width) of the selected element to the current selected line weight.

The currently selected line weight can be changed in the Line Menu.

NOT SUPPORTED IN THIS VERSION
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1.53 tool_sethatch

Set Hatch Tool

This tool allows you to hatch elements on screen by selecting them by the same methods as in Pick.

The elements will be hatched with the currently selected hatch type, which can be selected in the Hatch Palette.

1.54 tool_setlayer

Set Layer Tool

This tool lets you change the layer of the selected element to the current layer.

The current layer can be changed in the Layers requester.

1.55 tool_setall

Set All Tool

This tool lets you change all the attributes of an element.

This means that the Color, Line Style, Line Weight, Hatch and Layer of the entity will be set to the current values.

1.56 symbolcreatesymbol

Create Symbol

This creates a symbol from the currently selected entities. This tool works only with prepicked elements.

The symbol will be saved in a symbol file with the name the user supplies.

1.57 symbolplacesymbol

Place Symbol

This tool is used to place a symbol in a project. A requester appears and lets the user select the appropriate symbol. This symbol
is loaded and the user may move it around and place it in the project window.

1.58 symbolexplodesymbol

Explode Symbol

This tool is used to explode a symbol into its different elements. A symbol must be selected for this tool to be effective.

When selecting this tool, the symbol will replaced by the individual elements that forms the symbol. These elements can then be
edited by themselves.

1.59 snapmgrids

Grid snap

The grid snap snaps the input point to the closest point on the reference grid.

Grid Snap Switch
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1.60 }

Grid Snap Switch

Toggles the grid snap mode on and off. When Grid Snap mode is on, snapping occurs to the closest point on the reference grid,
as defined in the Grid Settings requester.

Note that this mode may be overruled by the directional or object snap modes.

1.61 snapmdirec

Directional snap

The directional snap modes snaps the input coordinate to the closest direction (by angle).

None

Orthogonal

Orthogonal 45

1.62 tool_snapdirnone

None

Turns off any directional snap.

Note that the directional snap modes may be overruled by the object snap modes.

1.63 tool_snapdirortho

Orthogonal

When orthogonal snapping is active, snapping occurs to a line parallell with either the x or y axis.

Note that the directional snap modes may be overruled by the object snap modes.

1.64 tool_snapdirortho45

Orthogonal 45

When orthogonal 45 snapping is active, snapping occurs to a line 45 degrees to either the x or y axis.

Note that the directional snap modes may be overruled by the object snap modes.

1.65 snapmobjec

Object snap

The object snap modes snaps to the closest point in an element.

None

Point

Midpoint
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1.66 tool_snapobjnone

None

Turns off any object snap.

1.67 tool_snapobjpoint

Point

When snap to point is active, snapping occurs to the closest point which is in an element.

Note that the object snap modes overrules all other snap modes.

1.68 tool_snapobjmidpoint

Midpoint

When snap to midpoint is active, snapping occurs to the closest midpoint which is on a line in an element.

This mode will also snap to the center of circles, ellipses and arcs.

Note that the object snap modes overrules all other snap modes.

1.69 menusproje

Project Menu

The Project Menu contains everything that has to do with opening and closing projects and files.

New

New Window

Open...

Save

Save As...

Close

Print Setup...

Print

About

Quit

1.70 menuprojnew

New

This opens a new project. If the current open project is changed, you will be asked if you want to save before opening a new
project.

Preferences will be read from the current preferences file.
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1.71 menuprojnewwindow

New Window

This opens a new window unto the current project.

NOT AVAILABLE IN THE CURRENT VERSION.

1.72 menuprojopen

Open...

This displays the filerequester and lets the user select a new project to load.

If the current open project is changed, you will be asked if you want to save before opening a new project.

1.73 menuprojclose

Close

Closes the current project.

If the current open project is changed, you will be asked if you want to save before opening a new project.

1.74 menuprojsave

Save

Saves the current project with the current filename.

1.75 menuprojsaveas

Save as

Opens a save requester and allows you to type in a new name for this project, and saves it under this name.

1.76 menuprojprintsetup

Print Setup...

Displays the Print Setup requester and lets you print the current project.

1.77 req_print

The Print Setup Requester

This requester lets you change the print setup settings.

Print Scale - The scale of the printed drawing.

Print Direction - Sets the printing to either Landscape or Portrait.

Print Type - Determines what part of the project that is to be printed. If Extents, everything will be printed. If Current View, the
part of the project that is shown in the project window will be printed.
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Options:

Print Grid - If checked, print the reference grid.

Print Axis - If checked, print the reference axis.

Print - Print with the current options.

Preview - Show a preview of the printout.

1.78 menuprojprint

Print

Prints the current project with the selections set in the Print Setup requester.

1.79 menuprojabout

About

This displays the ’About’ requester, where you can see the program credits and information about how much memory that is
available.

1.80 menuprojquit

Quit

This quits MagnifiCAD.

If the current open project is changed, you will be asked if you want to save before the program ends.

1.81 menusedit

Edit Menu

The items in the Edit Menu lets you cut and paste elements in a project and between different projects. It also has an item for
selecting all elements in a project.

Cut

Copy

Paste

Select All

1.82 menueditcut

Cut

This deletes the selected elements from the project and stores them in the clipboard, ready for a Paste operation. The clipboard
can hold any number of elements.

If there are old elements in the clipboard (from another Cut or Copy operation), they will be replaced by the new elements.
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1.83 menueditcopy

Copy

This copies the selected elements into the clipboard, replacing anything already there. It is the same as Cut, except it does not
delete the elements from the project.

1.84 menueditpaste

Paste

This pastes a copy of the elements in the clipboard into the project. The elements to be copied will be follow the position of the
mouse until the mouse is clicked to position them.

The elements will not be removed from the clipboard, so the Paste command can be used many times to paste many copies of the
same elements into the project.

The contents of the clipboard will not be deleted when closing a project and opening a new one, so it can be used for copying
elements from one project to another.

1.85 menueditselectall

Select All

This selects all the elements in a project. Elements in a layer that is not shown will not be selected.

1.86 menusview

View Menu

The items in the view menu lets you change the view you have of the project, zoom in and out, and save a specific view for later.

Zoom In

Zoom In By Factor

Zoom All

Zoom Out By Factor

Pan

Redraw

Save View

Views...

Coordinates and Snap Bar

Text Information Bar

Tools Palette

Color Palette

Hatch Palette

1.87 menu_zoomin

Zoom In

This lets you zoom in by drawing a rectangle which defines the bounds of the zoom.
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1.88 menu_zoominbyfactor

Zoom In By Factor

This calculates a new view based on the values in the Zoom Settings requester.

It zooms in by the number set in the Zoom Factor gadget in the Zoom Settings requester.

1.89 menu_zoomall

Zoom All

This zooms out until all elements are fully visible in the current project window.

1.90 menu_zoomoutbyfactor

Zoom Out By Factor

This calculates a new view based on the values in the Zoom Settings requester.

It zooms out by the number set in the Zoom Factor gadget in the Zoom Settings requester.

1.91 menu_pan

Pan

This lets you move the current view by drawing a line with the length and direction that the view moves.

1.92 menu_redraw

Redraw

This redraws the project with the current view.

1.93 menu_saveview

Save View

This lets you type in a name for the current view and saves it in the view list.

1.94 menu_views

Views...

Shows the view list and lets you select a new view.

1.95 menu_coordinatesandsnapbar

Coordinates and Snap Bar

Show or hide the Coordinates and Snap Bar. When the Coordinates and Snap Bar is shown, this item will be marked.
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1.96 menu_textinformationbar

Text Information Bar

Show or hide the Text Information Bar. When the Text Information Bar is shown, this item will be marked.

1.97 menu_toolspalette

Tools Palette

Show or hide the Tools Palette. When the Tools Palette is shown, this item will be marked.

1.98 menu_colorpalette

Color Palette

Show or hide the Color Palette. When the Color Palette is shown, this item will be marked.

1.99 req_color

Color Palette

This requester lets you select the current color. Select a color to make it the current selected color.

1.100 menu_hatchpalette

Hatch Palette

Show or hide the Hatch Palette. When the Hatch Palette is shown, this item will be marked.

1.101 req_hatch

Hatch Palette

This requester lets you select the current hatch. There are 16 different hatches available, from plain solid to a brick-like hatch.

Select the one you require by clicking on it. It will be depressed to show that it is selected.

1.102 menusinfor

Information Menu

The Information Menu contains items that shows the user information about the project, its layers, and its elements.

Project...

Layers...

Entities...

Select Font...
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1.103 menu_project

Project...

This displays the Project requester. In this requester you can change the name of the project and the file type.

1.104 req_project

The Project Requester

This requester lets you change the project name and file type.

Name - The project’s name.

File Type - The file type the project is saved in. The file types currently supported are:

MagnifiCAD

AutoCAD DXF 2D

For more information about these filetypes, see Appendix A.

1.105 menu_layers

Layers...

This displays the Layers requester. In this requester you can change number, name and status for each layer.

You change the active layer by clicking in the list of layers.

1.106 req_layers

The Layers Requester

This requester shows the layer list of the current project. You can add or delete layers, and change layer attributes.

Layer List:

Add - Add a new layer to the layer list.

Delete - Delete the currently selected layer.

Current Layer:

Number - The layers number.

Name - The layers name.

State - The layers state, either Show or Hide. When Show is selected, the layer’s entities will be drawn.

1.107 menu_entities

Entities...

This displays the Entity Info requester, which shows information about the selected entity. You can change information from this
Entity Info requester.

If there is more than one entity selected, selecting this item will do nothing.
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1.108 req_entities

The Entity Info Requester

This requester shows some information about the selected entity.

All entities:

Type - This shows the entity type. This can not be changed.

Layer - This shows the current layer the element is drawn in. Type in a new existing layer number to change the element’s layer.

Text:

String - The text that is drawn. This can be changed by editing the string.

Change Font... - Set a font specifically for this element. The font will be selected from the fonts requester.

Symbol:

Name - The name of symbol. This can be changed by typing a new name.

1.109 menu_selectfont

Select Font...

This displays the font requester and allows you to change another font than the default one to use as the selected entities text.

1.110 menussymbo

Symbols Menu

The Symbols menu contains items to let you create, place and explode symbols.

Place Symbol...

Create Symbol...

Explode Symbol

1.111 menu_placesymbol

Place Symbol...

Shows a requester, allowing you to choose the symbol you want to place in the project.

The symbol automatically follows the mouse pointer so you can move it around the screen and place it wherever you like.

1.112 menu_createsymbol

Create Symbol...

This saves the selected entities as one symbol, with the filename you enter in the save requester.

1.113 menu_explodesymbol

Explode

A symbol must be selected for this option to have any effect.

The symbol will be exploded into its different entities.
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1.114 menussetti

Settings Menu

The items in the settings menu lets you change all the settings in MagnifiCAD, and save this in a preference file.

Show Grid

Screen Mode...

Grid...

Units...

Zoom...

Load Settings...

Save Settings

Save Settings As...

1.115 menu_showgrid

Show Grid

Selecting this item will toggle it on or off. When on, the grid, as defined in the Grid Settings requester, will be displayed.

1.116 menu_screenmode

Screen Mode...

This displays the screenmode-requester and lets the user change screen resolution etc.

The screen modes currently supported by MagnifiCAD is:

o HIRES

o HIRES INTERLACE

o SUPERHIRES

o SUPERHIRES INTERLACE

Both PAL and NTSC modes are available.

1.117 menu_grid

Grid...

This shows the Grid Settings requester and lets you change the grid settings.

1.118 req_grid

The Grid Settings Requester

This requester shows the grid settings.

Grid Spacing - The spacing of the points or lines in the reference grid. If the spacing equals less than 2 pixels on the screen in
the current view, they will not be drawn.

Type - When set to Dot grid, only the points in the reference grid will be drawn. When set to Line grid, continous lines will be
drawn as the reference grid.
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1.119 menu_units

Units...

This shows the Units Settings requester and lets you change the units settings.

1.120 req_units

The Units Settings Requester

This requester shows the Units settings.

Units - The base units which all measures are made in. The base unit is used when calculating scale.

1.121 menu_zoom

Zoom...

This shows the Zoom Settings requester and lets you change the zoom settings. They affect how the view is zoomed when using
one of the zoom commands.

1.122 req_zoom

The Zoom Settings Requester

This requester shows the zoom settings.

Zoom Factor - This is the factor that is used in calculating new views when selecting Zoom In By Factor or Zoom Out By Factor.

Always Zoom By Factor - When checked, the Zoom Factor is used in all zooming operations, i.e. Zoom All and Zoom In. These
operations will then always scale by Zoom Factor.

1.123 menu_loadsettings

Load Settings...

This lets you change the settings by loading a previously saved settings file from disk.

1.124 menu_savesettings

Save Settings

This saves the settings in the currently defined file.

1.125 savesettingsas

Save Settings as...

This saves the settings in a file with a filename selected by the user.
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1.126 menuslines

Lines Menu

In this menu you can select the current Line Style and the current Line Weight.

A selection mark will show the current Line Style and the current Line Weight.

LINE WEIGHT NOT SUPPORTED IN THIS VERSION.

1.127 menushelp

Help Menu

In this menu you can get help from the online help included in MagnifiCAD.

Help

Using MagnifiCAD Help

Index

1.128 menu_help

Help

This opens the online help and displays the main help page.

From this page you can select different topics.

go to the ’Contents’ page

1.129 menu_usingmagnificadhelp

Using MagnifiCAD Help

This shows the ’help about help’ page, where the different

ways of getting help are listed.

go to the ’Using MagnifiCAD Help’ page

1.130 menu_index

Index

This shows the help index, with an entry for all topics and

keywords on which there is information in the online help

section.

go to the ’Index’ page
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1.131 appusing

Appendix A: Using MagnifiCAD with other CAD programs

MagnifiCAD can be used in conjunction with other CAD type

programs, both on the Amiga and on other platforms. Use

one of the supported file formats to transfer a project into

another program.

Supported File Formats

The only currently supported file format is the DXF drawing

files.

AutoCAD DXF 2D

1.132 appusiautoc

AutoCAD DXF 2D

MagnifiCAD reads and writes AutoCAD DXF files. This is the

most standard filetype for CAD drawings, and may be

imported into a variety of packages.

The supported entities are:

LINE

POLYLINE

CIRCLE

ARC

TEXT

MagnifiCAD reads the HEADER section, the TABLES section

(currently, the only table supported is LAYER), and the ENTITY

section, and skips the rest.

1.133 appspeed

Appendix B - Speed and Memory Issues

MagnifiCAD is supposed to work decently on an unexpanded

A1200, but it will be rather slow. To speed things up a bit,

there are several things that can be done.

· Select the normal HIRES screenmode, without interlace.

· Close the color and hatch palettes.

MagnifiCAD runs with just 300K free memory, but allocates

memory for each element added to a project. An unexpanded

A1200 has 2 megabytes of memory. This should be enough
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for many projects. If you run out of memory, try closing other

programs that are running and choose a screenmode with low

resolution.

The amount of free memory available can be checked by

choosing About in the Project menu.

1.134 appkeybo

Appendix C - Keyboard Shortcuts

All keyboard shortcuts consists of pressing the Amiga Key(A)

and another key, as shown in the table below.

Key

(A+) Does

A Save as... (Project Menu)

C Copy (Edit Menu)

H Help (Help Menu)

I Entity Info (Information Menu)

L Layers (Information Menu)

N New (Project Menu)

O Open (Project Menu)

P Print (Project Menu)

Q Quit (Project Menu)

R Redraw (View Menu)

S Save (Project Menu)

V Paste (Edit Menu)

W Views (View Menu)

X Cut (Edit Menu)

1.135 appindex

Appendix D - Index

<PLACE INDEX HERE>

1.136 howdoi

How Do I...?

Q: How do I speed things up?

A: Close the Color and Hatch Palettes, if they are open. Select the HIRES (no interlace) screenmode instead of a higher-resolution
screenmode.



MagnifiCAD_help 28 / 28

Q: I can’t seem to use the Set Hatch tool on the entities?

A: Hatching can only be applied inside an entity, i.e. the entity you select while ’Set Hatch’ is active will be filled with the
approprite hatch.

Q: How do I Print a drawing as Landscape?

A: Landscape printing in MagnifiCAD is not supported yet, but you can rotate your drawing by 90 degrees before you print it.
Look at the Print Preview to see how it looks.
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